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C H A P T E R 7

Configuring Features, Templates, Services, and 
Users

This chapter provides an overview of the feature configuration and setup, softkey template modification, 
services set up, and user assignment in Cisco Unified Communications Manager Administration. 
Cisco Unified Communications Manager documentation provides detailed instructions for these 
procedures.

This chapter includes the following sections: 

• Configuring Cisco Unified Wireless IP Phones in Cisco Unified Communications Manager, 
page 7-1

• Telephony Features Available for the Phone, page 7-2

• Specific Configuration Options for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G, page 7-14

• Configuring Softkey Templates, page 7-17

• Modifying Phone Button Templates, page 7-18

• Setting Up Services, page 7-18

• Java MIDlet Support, page 7-19

• Configuring Corporate and Personal Directories, page 7-20

• Adding Users to Cisco Unified Communications Manager, page 7-21

• Managing the User Options Web Pages, page 7-22

• Creating Custom Phone Rings, page 7-23

For suggestions about providing users with information for using the phone and features, see 
Appendix A, “Providing Information to Users By Using a Website.” For information about setting up 
phones in non-English environments, see Appendix B, “Supporting International Users.”

Configuring Cisco Unified Wireless IP Phones in Cisco Unified 
Communications Manager

To provide telephony call routing and call–control features for the Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G, you must use Cisco Unified Communications Manager 
Administration. For instructions about adding these devices, see the “Cisco Unified IP Phone 
Configuration” chapter in the Cisco Unified Communications Manager Administration Guide.
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Telephony Features Available for the Phone
Table 7-1 describes supported telephony features, that you can configure using 
Cisco Unified Communications Manager Administration for the Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G. The table provides references to documentation that contains 
configuration procedures and feature information.

For information about using the features on the phone, see Cisco Unified Wireless IP Phone 7925G, 
7925G-EX, and 7926G User Guide for Cisco Unified Communications Manager. 

Note Cisco Unified Communications Manager Administration also provides several service parameters that 
you can use to configure various telephony functions. For more information about service parameters 
and the functions that they control, you can use the I or ? button on the Cisco Unified Communications 
Manager configuration page. 

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G

Feature Description Configuration Reference

Abbreviated 
Dialing

Allows users to speed dial a phone number by entering an 
assigned code (1-99) on the phone keypad. Users assign the 
codes from the User Options web pages.

See Speed dial, page 7-13 for more information.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phone” chapter.

Auto Answer Connects incoming calls automatically after a ring or two 
to the speakerphone or headset if attached.

For more information, see the Cisco 
Unified Communications Manager 
Administration Guide:

• For Cisco Unified Communications 
Manager Release 5.0 or later, see the 
“Configuring Directory Numbers” 
chapter.

• For Cisco Unified Communications 
Manager Release 4.x, see the “Phone 
Configuration” chapter.

Auto-pickup Allows a user to use one-touch, pickup functionality for 
call pickup, group call pickup, and other group call pickup.

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Call Pickup Group 
Configuration” chapter.
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Barge Allows a user to join a non-private call on a shared phone 
line. Barge features include cBarge, Barge, and Single 
Button Barge.

• cBarge adds a user to a call and converts it into a 
conference, allowing the user and other parties to 
access conference features.

• Barge adds a user to a call but does not convert the call 
into a conference.

• Single Button Barge enables users to Barge or cBarge 
into a remote-in-use call on a shared line.

The phones support Barge in two conference modes:

• Built-in conference bridge at the target device (the 
phone that is being barged). This mode uses the Barge 
softkey.

• Shared conference bridge. This mode uses the cBarge 
softkey.

Note The Barge and Privacy features work together. See 
Privacy, page 7-11 for more information.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Device Pool Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Barge and Privacy” chapter.

Block external to 
external transfer

Prevents users from transferring an external call to another 
external number.

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “External Call Transfer 
Restrictions” chapter.

Busy Lamp Field 
(BLF) speed dial

Allows a user to monitor the call state of a directory 
number (DN) associated with a speed-dial button. The 
available states are: alerting, idle, busy, and do not disturb 
(DND). During the alerting state, call pickup capability is 
enabled.

Note This feature is not supported in Cisco Unified 
Communications Manager Release 4.x.

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Presence” chapter.

Call Back Provides users with an audio and visual alert on the phone 
when a busy or unavailable party becomes available.

For more information, see:

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Back” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Call display 
restrictions

Determines the information that will display for calling or 
connected lines, depending on the parties who are involved 
in the call.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, 
“Understanding Route Plans” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Display Restrictions” chapter.

Call forward Allows users to redirect incoming calls to another number. 
Call forward options include Call Forward All, Call 
Forward Busy, Call Forward No Answer, and Call Forward 
No Coverage.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Directory Number Configuration” 
chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Specifying Options that Appear on the 
User Options Web Pages, page 7-22

Call forward all 
loop breakout

Detects and prevents Call Forward All loops. When a Call 
Forward All loop is detected, the Call Forward All 
configuration is ignored and the call rings through.

For more information, see the Cisco 
Unified Communications Manager System 
Guide, “Cisco Unified IP Phones” chapter.

Call forward all 
loop prevention

Prevents a user from configuring a Call Forward All 
destination directly on the phone that creates a Call 
Forward All loop or that creates a Call Forward All chain 
with more hops than the existing Forward Maximum Hop 
Count service parameter allows.

For more information, see the Cisco 
Unified Communications Manager System 
Guide, “Cisco Unified IP Phones” chapter.

Call forward 
configurable 
display

Allows you to specify information that appears on a phone 
when a call is forwarded. This information can include the 
caller name, caller number, redirected number, and original 
dialed number.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

Call forward 
destination 
override

Allows you to override Call Forward All in cases where the 
Call Forward All target places a call to the Call Forward All 
initiator. This feature allows the Call Forward All target to 
reach the Call Forward All initiator for important calls. The 
override works whether the Call Forward All target phone 
number is internal or external.

For more information, see “Cisco Unified 
Communications Manager System Guide, 
“Cisco Unified IP Phones” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Call park Allows users to park (temporarily store) a call and then 
retrieve the call by using another phone in the Cisco 
Unified Communications Manager.

For more information, see:

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Park” chapter.

Call pickup Allows users to redirect a call that is ringing on another 
phone within their pickup group to their phone.

You can configure an audio and visual alert for the primary 
line on the phone. This alert notifies the users that a call is 
ringing in their pickup group.

Note The audio and visual alert is only available for 
phones on Cisco Unified Communications 
Manager Release 4.2 and later.

For more information, see:

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Pickup Group Configuration” 
chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter.

Call waiting Indicates (and allows users to answer) an incoming call that 
rings while on another call. Displays incoming call 
information on the phone screen.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter (Release 4.x).

• Cisco Unified Communications 
Manager Administration Guide, 
“Directory Number Configuration” 
chapter (Release 5.x and later).

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

Caller ID Displays caller identification such as a phone number, 
name, or other descriptive text on the phone screen.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Configuring Cisco Unified IP 
Phones” chapter.

• Cisco Unified Communications 
Manager System Guide, 
“Understanding Route Plans” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Display Restrictions” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Calling Party 
Normalization

Enables call backs to DNs that are routed through multiple 
geographical locations without having to modify the DN in 
the call log directories. DNs can be globalized and 
localized so that the appropriate calling number displays on 
the phone.

To globalize a DN, use the international escape character, 
plus (+).

For more information, see:

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Calling Party Normalization” 
chapter.

• Cisco Unified Communications 
Manager System Guide, “Using the 
International Escape Character +” 
chapter.

Client matter codes 
(CMC)

Enables a user to specify that a call relates to a specific 
client matter.

For more information, see the Cisco 
Unified Communications Manager 
Features and Services Guide, “Client 
Matter Codes and Forced Authorization 
Codes” chapter.

Conference Allows a user to talk simultaneously with multiple parties 
by calling each participant individually. Conference 
features include Conference, Join, cBarge, and Meet-Me.

Allows a non-initiator in a standard (ad hoc) conference to 
add or remove participants; also allows any conference 
participant to join together two standard conferences on the 
same line.

• For more information, see Cisco 
Unified Communications Manager 
System Guide, “Cisco Unified IP 
Phones” chapter.

• The Service parameter, 
AdvanceAdhocConference, (disabled 
by default in Cisco Unified 
Communications Manager 
Administration) allows you to enable 
these features. For more information, 
see the Cisco Unified Communications 
Manager System Guide “Conference 
Bridges” chapter.

Note Be sure to inform your users 
whether these features are 
activated.

Configurable call 
forward display

Allows you to specify information that appears on a phone 
when a call is forwarded. This information can include the 
caller name, caller number, redirected number, and original 
dialed number.

For more information, see:

• Cisco Unified Communications 
Manager 5.0 or later—Cisco Unified 
Communications Manager 
Administration Guide, “Directory 
Number Configuration” chapter

• Cisco Unified Communications 
Manager 4.x—Cisco Unified 
Communications Manager 
Administration Guide, “Cisco Unified 
IP Phone Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Direct transfer Allows a user to connect two calls to each other (without 
remaining on the line).

For more information, see Cisco Unified 
Communications Manager System Guide, 
“Cisco Unified IP Phones” chapter.

Directed Call Park Allows a user to transfer an active call to an available 
directed call park number that the user dials or speed dials. 
After pressing Transfer, the user dials the directed call park 
number to store the call.

Call Park BLF speed dial enables access to the directed call 
park number and indicates that the directed call park 
number is available or unavailable.

Note If you implement Directed Call Park, avoid 
configuring the Park softkey. This prevents users 
from confusing the two Call Park features. 

For more information, see:

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Park and Directed Call Park” 
chapter.

Do Not Disturb 
(DND)–Reject

Enables a user to temporarily busy out the phone when it is 
activated. If no call forwarding features are activated, calls 
to this station are routed to a busy signal or voice mail when 
DND–Reject is active. Otherwise, all incoming calls are 
routed to a preassigned call forwarding busy target.

Cisco Unified CallManager Features and 
Services Guide, “Do Not Disturb” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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DND When DND is turned on, no audible rings occur during the 
ringing-in state of a call or no audible or visual 
notifications of any type occur.

You can configure the phone to have a softkey template 
with a DND softkey or a phone-button template.

Note DND is available in Cisco Unified 
Communications Manager 6.0 or later.

The following DND parameters are configurable in 
Cisco Unified Communications Manager Administration:

• DND—This checkbox allows you to enable DND on a 
per-phone basis. Use Cisco Unified Communications 
Manager Administration > Device > Phone > Phone 
Configuration.

• DND Option—Choose “Call Reject” (to turn off all 
audible and visual notifications), or “Ringer Off” (to 
turn off only the ringer). DND Option appears on both 
the Common Phone Profile window and the Phone 
Configuration window (Phone Configuration window 
value takes precedence).

• DND Incoming Call Alert—Choose the type of alert to 
play, if any, on a phone for incoming calls when DND 
is active. This parameter is located on both the 
Common Phone Profile window and the Phone 
Configuration window (Phone Configuration window 
value takes precedence).

• BLF Status Depicts DND—Enables DND status to 
override busy/idle state.

For more information, see:

• Cisco Unified CallManager Features 
and Services Guide, “Do Not Disturb” 
chapter.

• Cisco Unified Communications 
Manager Administration Guide.

Extension Mobility Enables users to sign into their DN from any Cisco Unified 
IP Phone. It also enables users to temporarily apply a phone 
number and user profile settings to a Cisco Wireless 
Unified IP Phone by logging into the Extension Mobility 
service on that phone.

For more information, see: 

• Cisco Unified Serviceability 
Administration Guide

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Cisco Unified Communications 
Manager Extension Mobility” chapter.

• Cisco Unified Communications 
Manager Business Edition, “Cisco 
Extension Mobility” chapter.

Fast Dial Service Allows a user to enter a Fast Dial code to place a call. Fast 
Dial codes can be assigned to phone numbers or Personal 
Address Book entries. (See Services, page 7-12.)

For more information, see Cisco Unified 
Communications Manager System Guide, 
“Cisco Unified IP Phone Services” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
7-8
Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G Administration Guide



 

Chapter 7      Configuring Features, Templates, Services, and Users
Telephony Features Available for the Phone
Forced 
authorization 
codes (FAC)

Controls the types of calls that certain users can place. For more information, see Cisco 
Unified Communications Manager 
Features and Services Guide, “Client 
Matter Codes and Forced Authorization 
Codes” chapter.

Group call pickup Allows a user to answer a call ringing on a phone in another 
group by using a group pickup code.

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Call Pickup Group 
Configuration” chapter.

Hold Allows users to move connected calls from an active state 
to a held state.

Requires no configuration, unless you want 
to use music on hold; see Music on hold, 
page 7-11.

Hold Reversion Limits the amount of time that a call can be on hold before 
reverting back to the phone that put the call on hold and 
alerting the user.

Reverting calls are distinguished from incoming calls by a 
single ring (or beep, depending on the new call indicator 
setting for the line). This notification repeats at intervals if 
not resumed.

A call that triggers Hold Reversion displays a brief 
message on the status line.

You can configure call focus priority to favor incoming or 
reverting calls.

For more information about configuring 
this feature, see Cisco Unified 
CallManager Features and Services Guide, 
“Hold Reversion” chapter.

Hunt group Provides load sharing for calls to a main directory number. 
A hunt group contains a series of directory numbers that 
can answer the incoming calls. When the first directory 
number in the hunt group is busy, the system hunts in a 
predetermined sequence for the next available directory 
number in the group and directs the call to that phone. 

For more information, see: 

• Cisco Unified Communications 
Manager Administration Guide, “Hunt 
Group Configuration” chapter. 

• Cisco Unified Communications 
Manager System Guide, 
“Understanding Route Plans” chapter. 

Immediate Divert Allows a user to transfer a ringing, connected, or held call 
directly to a voice-messaging system.When a call is 
diverted, the line becomes available to make or receive new 
calls.

For more information, see: 

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Call Park and Directed Call Park” 
chapter

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Immediate 
Divert—Enhanced

Allows users to transfer incoming calls directly to their voice 
messaging system or to the voice messaging system of the 
original called party.

For more information, see: 

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Immediate Divert” chapter.

Intercom Allows users to place and receive intercom calls from the 
line view. You can configure intercom lines to:

• Directly dial a specific intercom extension.

• Initiate an intercom call and then prompt the user to 
enter a valid intercom number.

Users can view the intercom call history from the Directory 
menu.

For more information, see: 

• Cisco Unified CallManager Feature 
and Services Guide, “Intercom 
Configuration” chapter.

• Cisco Unified CallManager Feature 
and Services Guide, “Cisco Extension 
Mobility” chapter.

Join Across 
Lines/Select

Allows users to apply the Join feature to calls that are on 
multiple phone lines.

For more information, see:

• See Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

Join/Select Allows user to join two or more calls that are on one line to 
crate a conference call and remain on the call.

For more information, see Cisco 
Unified Communications Manager System 
Guide, “Cisco Unified IP Phones” chapter.

Log out of hunt 
groups

Allows users to log out of hunt groups and temporarily 
block calls from ringing their phone when they are not 
available to take calls. Logging out of hunt groups does not 
prevent non-hunt group calls from ringing their phones. 

For more information, see Cisco Unified 
Communications Manager System Guide, 
“Understanding Route Plans” chapter. 

Malicious caller 
identification 
(MCID)

Allows users to notify the system administrator about 
suspicious calls that are received.

For more information, see: 

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Malicious Call Identification” 
chapter.

Meet-Me 
conference

Allows a user to host a Meet-Me conference in which other 
participants call a predetermined number at a scheduled 
time.

For more information, see Cisco Unified 
Communications Manager Administration 
Guide, “Meet-Me Number/Pattern 
Configuration” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Message waiting 
indicator

A light on the handset that indicates that indicates that a 
user has one or more new voice messages.

For more information, see: 

• Cisco Unified Communications 
Manager Administration Guide, 
“Message Waiting Configuration” 
chapter.

• Cisco Unified Communications 
Manager System Guide, “Voice Mail 
Connectivity to Cisco Unified 
Communications Manager” chapter.

Multilevel 
Precedence and 
Preemption 
(MLPP)

Provides a method of prioritizing calls within your phone 
system. Use this feature when users work in an 
environment where they need to make and receive urgent or 
critical calls.

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Multilevel Precedence 
and Preemption” chapter.

Music on hold Plays music while callers are on hold. For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Music On Hold” chapter.

Onhook call 
transfer

Allows a user to press a single Transfer softkey and then go 
on-hook to complete a call transfer.

For more information, see Cisco Unified 
Communications Manager System Guide, 
“Cisco Unified IP Phones” chapter.

Other group pickup Allows a user to answer a call ringing on a phone in another 
group that is associated with the user's group.

(See Call pickup, page 7-5 and Group call pickup, 
page 7-9.)

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Call Pickup Group 
Configuration” chapter.

Presence-enabled 
directories

Allows a user to monitor the call state of another directory 
number (DN) listed in call logs, speed-dials, and corporate 
directories. The Busy Lamp Field (BLF) for the DN 
displays the call state.

For more information, see Cisco Unified 
Communications Manager Features and 
Services Guide, “Presence” chapter.

Privacy Enables a user to allow or disallow other users of 
shared-line devices to view the device all information or to 
enable another user to barge into its active call.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide 
“Barge and Privacy” chapter.

Push to Talk Allows users to call a target phone number or group and 
announce a message (similar to a two-way radio) by using 
a configurable applications button.

For more information, see “Setting Up 
Services” section on page 7-18.

Requires an XML application to provide 
Push to Talk service.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
7-11
Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G Administration Guide

 



 

Chapter 7      Configuring Features, Templates, Services, and Users
Telephony Features Available for the Phone
Quality Reporting 
Tool (QRT)

Allows users to use the QRT softkey on a phone to submit 
information about problem phone calls. QRT can be 
configured for either of two user modes, depending upon 
the amount of user interaction desired with QRT.

For more information, see:

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Quality Report Tool” chapter.

Redial Allows users to call the most recently dialed phone number 
by using a softkey option.

Requires no configuration.

Ring setting Identifies ring type used for a line when a phone has 
another active call.

For more information, see:

• Cisco Unified Communications 
Manager Release 4.x: Cisco Unified 
Communications Manager 
Administration Guide, “Cisco Unified 
IP Phone Configuration” chapter.

• Cisco Unified Communications 
Manager Release 5.x or later: Cisco 
Unified Communications Manager 
Administration Guide, “Configuring 
Directory Numbers” chapter.

• Cisco Unified Communications 
Manager Features and Services Guide, 
“Custom Phone Rings” chapter.

• “Creating Custom Phone Rings” 
section on page 7-23.

Services Allows you to use the Cisco Unified IP Phone Services 
Configuration menu in Cisco Unified Communications 
Manager Administration to define and maintain the list of 
phone services to which users can subscribe.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phone Services” chapter.

Shared Line Allows users to have multiple phones that share the same 
phone number or allows users to share a phone number 
with a coworker.

For more information, see Cisco Unified 
Communications Manager System Guide, 
“Cisco Unified IP Phones” chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)
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Related Topics

• Configuring Softkey Templates, page 7-17

• Setting Up Services, page 7-18

• Configuring Corporate and Personal Directories, page 7-20

• Adding Users to Cisco Unified Communications Manager, page 7-21

• Creating Custom Phone Rings, page 7-23

Speed dial Dials a specified number that has been previously stored.

Speed dialing includes these features:

• Speed-dial hot keys configured and stored in the local 
Phone Book on the wireless IP phone.

• Line view speed-dial numbers configured from the 
User Options web page.

See Abbreviated Dialing, page 7-2 and Fast Dial Service.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Unified IP Phone 
Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Cisco 
Unified IP Phones” chapter.

Time-of-Day 
Routing

Restricts access to specified telephony features by time 
period.

For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Time Period Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Time-of-Day 
Routing” chapter.

Transfer Allows users to redirect connected calls from their phones 
to another number.

Requires no configuration.

Voice message 
system

Enables callers to leave messages if calls are unanswered. For more information, see:

• Cisco Unified Communications 
Manager Administration Guide, 
“Cisco Voice-Mail Port 
Configuration” chapter.

• Cisco Unified Communications 
Manager System Guide, “Voice Mail 
Connectivity to Cisco 
Unified Communications Manager” 
chapter.

Table 7-1 Telephony Features for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G (continued)

Feature Description Configuration Reference
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Specific Configuration Options for the Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G

Each Cisco Unified IP Phone has special configuration options in Cisco Unified Communications 
Manager Administration that are available by phone model. The following product specific 
configuration options are available for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G:

• Disable Speakerphone—Turns off the speakerphone capability of the handset. Options are True or 
False.

• Gratuitous ARP—Enables or disables the ability for the phone to learn MAC addresses from 
Gratuitous ARP. This capability is required to monitor or record voice streams. Options are Enabled 
or Disabled.

• Settings Access—Enables, disables, or restricts access to local configuration settings in the Settings 
menus. With restricted access, only the Phone Settings menu is accessible. With disabled access, the 
Settings menu does not display any options. Options are Enabled, Disabled, and Restricted.

• Web Access—Determines the level of access to the web pages for the phone. Provides Disabled, 
Read only, and Full access to a phone’s web pages through a web browser. Options are Read Only, 
Full, Disabled.

• Profile 1-4—Locks or unlocks the network profiles. If locked, the phone user cannot modify the 
network profile. Options are Unlocked and Locked.

• Load Server—Identifies the alternate server that the phone uses to obtain firmware loads and 
upgrades. Enter an IP address or host name for the server.

• Admin Password (Cisco Unified Communications Manager Release 5.0 and later)—Password to 
access the configuration web pages for the phone. “CiscoCisco” is the default password. Password 
must be from 8 to 32 characters long.

Caution When setting the Administration Password in the Product Specific Configuration section in Cisco 
Unified Communications Manager Administration Release 5.0 or later, you must enable TFTP 
encryption. Otherwise, the password appears in readable text in the phone configuration file and can be 
viewed from any host that has access to TFTP server.

• Special Numbers—Identifies special phone numbers that do not require unlocking the keypad to 
call, such as 911 or an emergency number. Enter numbers up to 16 digits in length.

• Application URL—Specifies the URL that the phone uses to contact application services. The 
maximum length is 256 characters.

• “Send” Key Action—When enabled, pressing the green button causes the phone to go off-hook. 
When disabled, pressing the green button causes the phone displays the list of recently dialed 
numbers (for last number redial).

• Days Display Not Active—Specifies the days that the backlight is off by default. The list contains 
all the days of the week. To turn off the backlight on the specified days, use the Control key and 
select the days. Not supported on the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G.

• Display On Time—Indicates the time of day that the display turns on automatically. The time is 
input in 24-hour format; for example, to turn on the display at 2:00 p.m., you set this field to 14:00. 
Not supported on the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G. 
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• Display On Duration—Indicates the amount of time that the display is active. No value indicates the 
end of a day. Maximum value is 24 hours. Input the number of hours and minutes; for example, 1:30 
indicates a display time of 1 hour and 30 minutes. Not supported on the Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G.

• Display Idle Timeout—Specifies when the display times out after a configurable amount of 
inactivity. The timeout timer continually resets if the phone is active. The default is to time out after 
1 hour. Maximum value is 24 hours. Input the number of hours and minutes; for example, 1:30 
indicates a display time of 1 hour and 30 minutes. Not supported on the Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G.

• Phone Book Web Access—Controls the access of the local phone book so that it can be accessed by 
using the web page for the phone. This parameter works with the Web Access parameter. When Web 
Access is disabled, the local phone book is not accessible.

• Unlock-Settings Sequence (**#)—Specifies the unlock settings as **#. If this parameter is enabled, 
the phone cannot be unlocked using any other key sequence. The user does not have write-access to 
the phone Settings menu if this parameter is enabled unless the sequence is entered on the phone.

• Application Button Activation Timer—Specifies the amount of time to hold down the Application 
Button to active the application. Input the value in seconds.

• Application Button Priority—Indicates the priority of the Application Button relative to the other 
phone tasks. The Low option specifies that the Application Button works only when the phone is 
idle and on the main screen. The Medium option specifies that the button takes precedence over all 
tasks except when the keypad is locked. The High option specifies that the button takes precedence 
over all tasks on the phone.

• Out-of-Range Alert—Controls the frequency of audible alerts when the phone is out of range of an 
AP. The phone does not play audible alerts when the parameter value is “disabled.” The phone can 
beep one time or regularly at 10, 30, or 60 second intervals. When the phone is within range of an 
AP, the alert stops.

• Scan Mode—Controls the scanning by the phone. The parameter values are: 

– Auto: Phone scans when it is in a call or when the received strength signal indicator (RSSI) is 
low. The default is Auto.

– Single AP: Phone never scans except when the basic service set (BSS) is lost. 

– Continuous: Phone scans continuously even when it is not in a call.

• Restricted Data Rate—Enables or disables the restriction of the upstream and downstream PHY 
rates according to CCX V4 Traffic Stream Rate Set IE (S54.2.6). The default is disabled.

• Power Off When Charging—Indicates whether the phone powers off when it is connected to a 
charger or placed in a charging station. The default is disabled.

• Cisco Discovery Protocol—Enables or disables the Cisco Discovery Protocol on the phone. The 
default is enabled.

• Advertise G.722 Codec—Indicates whether the phone advertises the G.722 codec to the Cisco 
Unified Communications Manager. Codec negotiation involves two steps: 

a. The phone must advertise the supported codec to the Cisco Unified Communications Manager 
(not all endpoints support the same set of codecs). 

b. When the Cisco Unified Communications Manager gets the list of supported codecs from all 
phones involved in the call attempt, it chooses a commonly supported codec based on various 
factors, including the region pair setting. 

Valid values are: 
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– Use System Default (defers to the setting specified in the enterprise parameter, Advertise G.722 
Codec). The default is Use System Default.

– Disabled (does not advertise G.722 to the Cisco Unified Communications Manager).

– Enabled (advertises G.722 to the Cisco Unified Communications Manager). 

• Home Screen—Enables two views on the phone: Main Phone Screen or Line View. The default is 
the Main Phone Screen.

• FIPS Mode—Enables or disables the Federal Information Processing Standards (FIPS) mode on the 
phone. The default is disabled.

• Auto Line Select—Enables or disables the Auto Line Select feature on the phone. If enabled, the 
phone shifts the call focus to incoming calls on all lines. If disabled, the phone shifts only the call 
focus to incoming calls on the currently used line. The default is disabled.

• Bluetooth—Enables or disables the Bluetooth option on the phone. If disabled, the user cannot 
enable Bluetooth on the phone. The default is enabled.

• File System Verification—Enables the phone to perform a file system integrity check as part of the 
firmware upgrade process. This parameter is used to troubleshoot file system issues. Enabling this 
feature may impact phone performance. The default is disabled.

• Bar Code Symbology Group—Specifies the symbology the scanner uses to scan barcodes. Select 
either basic or extended depending on the barcode types being used. Only available on the Cisco 
Unified Wireless IP Phone 7926G. The default is basic.

• Scanner Commands—Allows you to specify multiple commands for barcode scanner features. For 
more information, see the Java MIDlet Developers Guide for Cisco Unified IP Phones and the Cisco 
IP Phone Services MIDlet Software Development Kit. Only available on the Cisco Unified Wireless 
IP Phone 7926G.

• Minimum Ring Volume—If a user does not have access to the phone configuration menus, this 
setting controls the minimum ring volume a user can adjust the volume to. The default is 5.

To configure product specific options, follow these steps:

Procedure

Step 1 From Cisco Unified Communications Manager Administration, choose Device > Phone.

Step 2 Do one of the following actions:

• For Cisco Unified Communications Manager 4.x or earlier, click Add a Phone. 

• For Cisco Unified Communications Manager 5.0 and later, click Add Phone.

Step 3 Choose Phone Type > Cisco7925.

Step 4 In the Phone Configuration page, locate the Product Specific Configuration area.

Step 5 Make changes to the settings as needed. 

Note For detailed information about these settings, click the I or ? button for Product Specific 
Configuration Help. 

Step 6 Select the Override Common Settings checkbox to override higher level configuration settings for that 
feature.
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Step 7 Reset the phone to make the changes take effect.

Configuring Softkey Templates
Administrators can change the order of softkeys for the Cisco Unified Wireless IP Phone 7925G, 
7925G-EX, and 7926G by using Cisco Unified Communications Manager Administration. Unlike other 
Cisco Unified IP Phones that have buttons for some functions, the Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G has two non-configurable softkeys that are set for: 

• Message

• Options

When you configure a softkey template for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G, you can only configure the Cisco Unified Communications Manager softkeys and their sequence 
in the Options menu. The order of softkeys in the softkey template corresponds to the phone softkey list 
in the Options menu. When you set up the softkey template for users that prefer to have a particular 
softkey appear during a connected call, place the desired softkey in the first position for the Connected 
phone state. 

Softkey Templates for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, 
and 7926G

The standard softkey template displays the Hold softkey when connected to a call. Some users want the 
Transfer softkey to appear for a connected call instead of Hold. 

To change the softkey that displays, the administrator sets up a non-standard softkey template that places 
Transfer in the first position for the Connected state. The administrator assigns this non-standard softkey 
template to the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G assigned to users that 
want these softkeys. 

Note To ensure that users hear the voice-messaging greeting when they are transferred to the voice message 
system, you must set up a softkey template with Transfer as the first softkey for a connected call.

Changing Softkeys in a Template
Use the procedures in the online Help topic, “Adding Non-Standard Softkey Templates” to change the 
softkeys and their sequence. Softkey templates support up to 16 softkeys when using applications. For 
more information about softkey templates, see the “Softkey Templates” Chapter in the Cisco 
Unified Communications Manager System Guide.

To configure softkey templates, select Device > Device Settings > Softkey Template from 
Cisco Unified Communications Manager Administration. You can modify a standard softkey template 
by making a copy of it, giving it a new name, and making updates to that copied softkey template. You 
can also modify a nonstandard softkey template.
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Modifying Phone Button Templates
To assign a softkey template to a phone, use the Softkey Template field in the 
Cisco Unified Communications Manager Administration Phone Configuration page. See the “Softkey 
Template Configuration” chapter in the Cisco Unified Communications Manager Administration Guide 
and the Cisco Unified Communications Manager System Guide for more information.

Related Topics

• Specific Configuration Options for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G, page 7-14

• Setting Up Services, page 7-18

• Configuring Corporate and Personal Directories, page 7-20

• Adding Users to Cisco Unified Communications Manager, page 7-21

Modifying Phone Button Templates
Phone button templates let you assign lines and features to positions in the Line View. Ideally, you 
modify templates before registering phones on the network. In this way, you can access customized 
phone button template options from Cisco Unified Communications Manager during registration.

To modify a phone button template, choose Device > Device Settings > Phone Button Template from 
Cisco Unified Communications Manager Administration. To assign a phone button template to a phone, 
use the Phone Button Template field in the Cisco Unified Communications Manager Administration 
Phone Configuration page. For more information about modifying phone button templates, see “Cisco 
Unified IP Phones” chapter in the Cisco Unified Communications Manager System Guide for your 
release.

The Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G can have up to six lines and up to 
24 connected calls. The default button template uses position 1 for lines and assigns positions 2 through 
6 as speed dial. You can assign the following features to button positions:

• Service URL

• Privacy

• Speed dial

Use softkey features in the Options menu to access other phone features, such as call park, call forward, 
redial, hold, resume, conferencing, and so on.

Setting Up Services
The Services menu on the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G gives users 
access to Cisco Unified IP Phone Services. These services are XML applications or Java MIDlets that 
enable the display of interactive content with text and graphics on the phone. Examples of services 
include Push to Talk, directories, stock quotes, and weather reports. Some services, such as Push to Talk, 
can use the configurable Applications button located on the side of the phone.

To create customized XML applications for your site, see the Cisco Unified IP Phone Service 
Application Development Notes.

Before a user can access any service, two important tasks must be completed:

• The system administrator must use Cisco Unified Communications Manager Administration to 
configure available services.
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• The user must subscribe to services using the Cisco Unified IP Phone User Options application. This 
web-based application provides a graphical user interface (GUI) for limited, end-user configuration 
of IP Phone applications.

To set up IP Phone services, follow these steps:

Procedure

Step 1 Before you set up services, gather the URLs for the sites you want to set up and verify that users can 
access those sites from your corporate IP telephony network. 

Step 2 To set up these services in Cisco Unified Communications Manager Administration for Release 4.x, 
choose Feature > Cisco IP Phone Services.
or
To set up these services in Cisco Unified Communications Manager Administration for Release 5.0 or 
later, choose Device > Device Settings > Phone Services.

For more information about phone services, see the “Cisco Unified IP Phone Services” chapter in the 
Cisco Unified Communications Manager System Guide for more information.

Step 3 After you configure these services, verify that your users have access to the 
Cisco Unified Communications Manager User Options web-based application, from which they can 
select and subscribe to configured services. See “How Users Configure Phone Features and Services” 
section on page A-4 for a summary of the information that you must provide to end users.

Note For information about extension mobility services for users, see the “Cisco Extension Mobility” chapter 
in the Cisco Unified Communications Manager Features and Services Guide.

Related Topics

• Specific Configuration Options for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G, page 7-14

• Configuring Softkey Templates, page 7-17

• Configuring Corporate and Personal Directories, page 7-20

• Adding Users to Cisco Unified Communications Manager, page 7-21

• Creating Custom Phone Rings, page 7-23

Java MIDlet Support
The Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G supports the use of Java MIDlets 
offered by Cisco vendors and third-party developers. Running Java MIDlet applications directly on the 
phone allows more sophisticated application capabilities than with existing XML services, such as 
animated graphics, custom user interface objects, advanced network connectivity, and persistent local 
storage. Because Java MIDlets are an industry standard, developers can use standard Java development 
tools for building applications.
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Configuring Corporate and Personal Directories
Cisco Unified Communications Manager IP Phone Service provisioning and subscription interfaces 
(CUCM Admin and CUCMUser) have been enhanced to allow for explicit provisioning of IP Phone 
Services via the phone’s configuration file. This new explicit provisioning system allows Java MIDlet 
applications to be installed and managed on the phone. When a new service is added in the configuration, 
the phone downloads and installs it. When a service is removed, the phone uninstalls it.

For more information on Java MIDlets, see the Java MIDlet Developers Guide for Cisco Unified IP 
Phones and the Cisco IP Phone Services MIDlet Software Development Kit.

Configuring Corporate and Personal Directories
The Directory menu on the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G gives users 
access to several directories. These directories can include:

• Corporate Directory—Allows a user to look up phone numbers for co-workers.

To support this feature, you must configure corporate directories. See “Configuring Corporate 
Directories” section on page 7-20 for more information.

• Personal Directory—Allows a user to store a set of personal numbers.

To support this feature, you must provide the user with software to configure the personal directory. 
See “Configuring Personal Directory” section on page 7-20 for more information.

Configuring Corporate Directories
Cisco Unified Communications Manager uses a Lightweight Directory Access Protocol (LDAP) 
directory to store authentication and authorization information about users of Cisco Unified 
Communications Manager applications that interface with Cisco Unified Communications Manager. 
Authentication establishes the users’ rights to access the system. Authorization identifies the telephony 
resources that a user is permitted to use, such as a specific telephone extension.

To install and set up these features, see the Cisco Unified Communications Manager Administration 
Guide, LDAP System Configuration, LDAP Directory Configuration, and LDAP Authentication 
Configuration chapters. That manual guides you through the configuration process for integrating Cisco 
Unified Communications Manager with Microsoft Active Directory, Sun ONE Directory, Netscape 
Directory, and iPlanet Directory Server.

After the LDAP directory configuration completes, users can use the Corporate Directory service on 
your Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G to look up users in the corporate 
directory. 

Configuring Personal Directory
Personal Directory consists of the following features:

• Personal Address Book (PAB)

• Personal Fast Dials (Fast Dials)

• Address Book Synchronization Tool (TABSynch)

Users can configure personal directory entries on the Cisco Unified IP Phone. To configure a personal 
directory, users must have access to the following:
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• User Options web pages—Make sure that users know how to access their User Options web pages. 
See “How Users Configure Phone Features and Services” section on page A-4 for details.

• Cisco Unified IP Phone Address Book Synchronizer—Make sure to provide users with the installer 
for this application. 

Obtaining the Cisco Unified IP Phone Address Book Synchronizer Application

To obtain the installer, 

Step 1 Choose Application > Plugins > Installation from Cisco Unified Communications Manager 
Administration

Step 2 Click Download, which is located next to the Cisco Unified IP Phone Address Book Synchronizer 
plugin name. 

Step 3 When the file download dialog box displays, click Save. 

Step 4 Send the TabSyncInstall.exe file to all users who require this application.

Adding Users to Cisco Unified Communications Manager
Adding users to Cisco Unified Communications Manager Administration allows you to display and 
maintain information about users and allows each user to perform the following actions:

• Access the corporate directory and other customized directories from a Cisco Unified IP Phone

• Create a personal directory

• Set up speed dial and call forwarding numbers 

• Subscribe to services that are accessible from a Cisco Unified IP Phone

You can add users to Cisco Unified Communications Manager using one of these methods:

• To add users individually from Cisco Unified Communications Manager Administration for Release 
5.0 or later, choose User Management > End User > Add New.

See “Adding a New User” chapter in Cisco Unified Communications Manager Administration Guide 
for more information about adding users. See Cisco Unified Communications Manager System 
Guide for details about user information.

• To add users individually from Cisco Unified Communications Manager Administration for Release 
4.x, choose User > Add a New User.

See “Adding a New User” chapter in Cisco Unified Communications Manager Administration Guide 
for more information about adding users. See Cisco Unified Communications Manager System 
Guide for details about user information.

• To add users in batches, use the Bulk Administration Tool. This method also enables you to set an 
identical default password for all users.

For detailed information, see Bulk Administration Tool User Guide (Cisco Unified Communications 
Manager Release 4.3 or later) or Cisco Unified Communications Manager Bulk Administration 
Guide (Cisco Unified Communications Manager Release 5.0 or later).
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Related Topics

• Specific Configuration Options for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G, page 7-14

• Configuring Softkey Templates, page 7-17

• Configuring Corporate and Personal Directories, page 7-20

• Adding Users to Cisco Unified Communications Manager, page 7-21

• Creating Custom Phone Rings, page 7-23

Managing the User Options Web Pages
From the User Options web page, users can customize and control several phone features and settings. 
For detailed information about the User Options web pages, see Cisco Unified Wireless 
IP Phone 7925G, 7925G-EX, and 7926G User Guide.

Giving Users Access to the User Options Web Pages
Before a user can access the User Options web pages, you must use Cisco Unified Communications 
Manager Administration to add the user to a standard Cisco Unified Communications Manager end user 
group and associate appropriate phones with the user. 

To perform this procedure, do the following:

Cisco Unified Communications Manager Administration for Release 5.x and Later

Step 1 From User Management > User Group, choose User Management > End User.

Step 2 Add the username.

Step 3 Add the phone.

Step 4 Associate the phone to the user.

Step 5 Add the user to a user group.

For Cisco Unified Communications Manager Administration for Release 4.x, see Cisco Unified 
Communications Manager Administration Guide, “End User Configuration” section.

Note You can use Cisco Unified Communications Manager Administration to control user access to the phone 
web pages. For information about setting Web Access for users, see “Specific Configuration Options for 
the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 7926G” section on page 7-14.

Specifying Options that Appear on the User Options Web Pages
Most options that are on the User Options web pages appear by default. However, the following options 
must be set by the system administrator using Enterprise Parameters Configuration settings in Cisco 
Unified Communications Manager Administration:
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• Show Ring Settings

• Show Line Text Label Settings

• Show Call Forwarding

Note The settings apply to all User Options web pages at your site.

To specify the options that appear on the User Options web pages, follow these steps:

Procedure

Step 1 From Cisco Unified Communications Manager Administration, choose System > Enterprise 
Parameters.

The Enterprise Parameters Configuration window displays.

Step 2 In the CCMUser Parameters area, specify whether a parameter appears on the User Options web pages 
by choosing one of these values from the Parameter Value drop-down list box for the parameter:

• True—Option displays on the User Options web pages (default).

• False—Option does not display on the User Options web pages.

• Show All Settings—All call forward settings display on the User Options web pages (default).

• Hide All Settings—No call forward settings display on the User Options web pages.

• Show Only Call Forward All—Only call forward all calls displays on the User Options web pages.

Creating Custom Phone Rings
You can customize the phone ring types available at your site by using a set of phone ring sounds 
provided by Cisco Unified Communications Manager or by creating your own pulse code modulation 
(PCM) files and editing the RingList.xml file. See the “Custom Phone Rings” chapter in the Cisco 
Unified Communications Manager Features and Services Guide for more information about customized 
ring tones.

Related Topics

• Specific Configuration Options for the Cisco Unified Wireless IP Phone 7925G, 7925G-EX, and 
7926G, page 7-14

• Configuring Softkey Templates, page 7-17

• Configuring Corporate and Personal Directories, page 7-20

• Adding Users to Cisco Unified Communications Manager, page 7-21

• Creating Custom Phone Rings, page 7-23
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